Program Development Tools

Introduction

The objective of this module is to understand the basic functions of the Code Composer Studio®
(CCS) Integrated Design Environment (IDE) for the C2000 Family of Texas Instruments Digital
Signal Processors and Microcontrollers. This involves understanding the basic structure of a
project in C and Assembler coded source files, along with the basic operation of the C -
Compiler, Assembler and Linker.

Code Composer Studio IDE, Version 4

Note: This chapter explains the use of Code Composer Studio, Version 4 and later. This revision
is based on Eclipse and introduced a major change of the design environment compared to earlier
CCS versions. If you use an older version, please refer to the previous releases of this teaching
CD-ROM.

Code Composer Studio is the environment for project development and for all tools needed to
build an application for the C2000 family.

Code Composer Studio Version 4 2
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CCS 4: Eclipse Concepts

With CCS version 4 Texas instruments moved the Integrated Design Environment to an Eclipse
(www.eclipse.org) open source software framework. Hence understanding some of the basic
concepts of Eclipse will lead to a better understanding of CCSv4. Some of the more commonly
referenced concepts are described below.

CCS4 Eclipse Concepts 2

CCS 4 - based on Eclipse

* Open source framework (www.eclipse.orq)

Commonly referenced categories:
 Workbenches
 Workspaces
» Perspectives

 Views
e Resources
* Projects
* Files
Workbench

A Workbench contains all the various views and resources used for development and debug.
Multiple CCSv4 Workbench windows can be opened (‘Window->New Window'). While each
Workbench window can differ visually (arrangement of views, toolbars and such), all windows
refer to the same workspace and the same running instance of CCSv4 - if a project is opened from
one Workbench, that same project will be open in all the Workbench windows.
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Workspace

The workspace is the main working folder for CCSv4 and where it stores project information to
manage all the projects that you define to it. This is the case even if the projects themselves do
not physically reside inside the workspace folder. CCSv4 Workspaces are not to be confused with
CCSv3 workspace files (*.wks), which have more in common with CCSv4 Perspectives than they
do with CCSv4 workspaces. The default location of any new projects created in CCSv4 will be
within the workspace folder. Once a project has been defined to the workspace, it will be visible
in the 'C/C++ Projects' view and can be opened and closed and such. To define an existing
CCSv4 project to the workspace, it will need to be imported into CCSv4.

CCSv4 will prompt the user for the workspace folder location when launching CCSv4. The
workspace folder is also used by CCSv4 to store other information such as user preferences,
custom perspectives, cached data for plug-ins, etc.

Multiple workspaces may be maintained (for example, one for each user), however only one can
be active within each CCSv4 instance. The 'File->Switch Workspace..." option can be used to
switch between the workspaces. Each workspace would have its own stored user preferences and
projects associated with it.

Perspective

A perspective (compare Slide 3-2) defines the initial set and layout of views in the Workbench
window. Each perspective provides a set of functionality aimed at accomplishing a specific type
of task. For example, the default 'C/C++' perspective displays views most commonly used during
code development, such as the 'C/C++ Projects' view, 'Outline' view and the Editor. When a de-
bug session is started, CCSv4 will automatically switch to the 'Debug' perspective, which (by de-
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fault) displays the 'Debug' view, 'Watch' view and 'Local’ view. Also in the 'Debug' perspective,
menus and toolbars associated with debugging (such as target connect, load program, reset target,
etc) are now available. Users can also manually switch between perspectives. Any changes made
to a perspective will be preserved (but can be reset to the default arrangement via = Window=>
Reset Perspective). New perspectives can be created simply by saving the current perspective as a
new name (=» Window =»Save Perspective As...).

Perspectives can be easily switched between perspectives by clicking on the perspective icons in
the upper right corner.

Views

Views are windows within the main Workbench window that provide visual representation of
some specific information. The Workbench window mainly consists of the editor and a collection
of views. Examples of some views are “C/C++ Projects”, “Debug”, “Outline”, “Memory”,
“Disassembly”, etc.

Most of the views in CCSv4 are available from the main “View” menu.

Resources

“Resources” is a collective term for the projects, folders, and files that exist in the Workbench.

Projects

“Projects” typically contain folders and files. Like the workspace, projects map to directories in
the file system.

Files

“Files” can either be added or linked to a project. When a file is added to a project, the file is
copied to the root location of the project directory. This differs from the concept of “adding” a
file to a CCSv3 project, where it would not make a local copy, but simply make a reference to
where the file is located (you were adding a reference to the file in your project). To achieve the
same functionality with CCSv4 projects, there is also the option to “link” a file to a project. This
will simply have the project create a reference to the file instead of copying the file into the
project directory.
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The Software Flow

The following slide (Slide 3-4) illustrates the software design flow within Code Composer Studio.
The basic steps are: edit, compile and link, which are combined into “build”, then debug. If you
are familiar with other Eclipse based Integrated Design Environments, you will easily recognize
the typical steps used in a project design. If not, you will have to spend a little more time to
practice with the basic tools shown on this slide. The major difference to a PC design toolbox is
shown on the right-hand side - the connections to real-time hardware!

Code Composer Studio 2
Build — S.Cofet
Compile Ink.cmd Anuaor
l
— eZdsp™
Asm [ Link p~ Debug
I |
. — Emulator
Editor Libraries Graphs! (XDSlOO)
Profiling
!
MCU
Board

* Code Composer Studio includes:
— Integrated Edit/Debug Graphical User Interface
— Code Generation Tools
— Real — Time Operating System (DSP/BIOS)

You can use Code Composer Studio with a Simulator (running on the Host - PC) or you can
connect a microcontroller system and test the software on a real “target”. For this tutorial, we will
rely on the Peripheral Explorer Board and the TMS320F28335 Control Card as our “target”. Here
the word “target” means the physical processor we are using, in this case a TMS320F28335.

Before we inspect some basic features of Code Composer Studio Version 4 more in detail, we
will first discuss the hardware setup for lab exercises that follow.
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Lab Hardware Setup

The following slides illustrate the hardware target that will be used during our lab exercises in the
chapters that follow. The core is the TMS320F2335 32-bit Digital Signal Controller on board of a
Texas Instruments “Peripheral Explorer Board”. All the major internal peripherals are available
through connectors. The JTAG interface connects the board to the PC via a USB link.

Slide 3-5 reveals all peripheral units, which are populated at the Peripheral Explorer Board
(Texas Instruments part number: TMDSPREX28335).

é Peripheral Explorer Board @

USB connector
for on-board
emulation (JP1)

SCI Boat Pins

To be able to practice with all the peripheral units of the Digital Signal Controller and some ‘real’
process hardware, the Peripheral Explorer Board provides:

e 4 LEDs for digital output (GP109, GPIO11, GP1034 and GP1049)

e a4 - bit hexadecimal input encoder (GP1012...GP1015) and 2 push buttons (GPIO 34
and GP1017) for digital inputs

e 2 potentiometers (ADCINAO, ADCINAL) for analog inputs
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e 1 stereo audio codec AIC23B for line -in and headphone -out (connected via McBSP and
SPI)

o 1 SPI 256k - Atmel AT25C256 EEPROM (connected via McBSP)

e 1 CAN Transceiver - Texas Instruments SN 65HVD230 (high speed)
e 1 1°C - Temperature Sensor Texas Instruments TMP100

e 1 SCI-A RS232 Transceiver - Texas Instruments MAX232D

o 1 Infrared Receiver TSOP32230 (connected to eCAP)

Slide 3-6 shows the F28335 Control Card, which we will use for our teaching course.

Teachers: Please note that the F28335ControlCard is already bundled with the Peripheral
Explorer Board. In case that you need additional spare modules of this control card, the part
number is TMDSCNCD28335.

Other versions of C2000 Control Cards are also available.

F28335 Control Card @

» Low cost single-board controllers
» perfect for initial development and small
volume system builds.

» Small form factor with standard 100-pin
DIMM interface

» F28x analog I/O, digital I/0, and JTAG
signals available at DIMM interface

* Isolated RS-232 interface

* Single 5V power supply required

» \Versions:

 “Piccolo” F28027 (TMDXCNCD28027)
“Piccolo” F28035 (TMDXCNCD28035)
F28044 (TMDSCNCD28044)
F2808 (TMDSCNCD2808)
“Delfino” F28335 (TMDSCNCD28335)
“Delfino” C28343 (TMDXCNCD28343)

3-6
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Code Composer Studio Version 4 - Step by Step

Now let us start to look a little closer at the main parts of Code Composer Studio Version 4 that
we need to develop our first project. We will perform the following steps:

Learning by doing - Step by Step <2>

Code Composer Studio V4 - The Basics
CCS workspace and welcome window

Create a F2833x - project, based on C language
Debug your program

Watch your variables

Perform a Single Step Debug

Use Breakpoints

Real — Time — Debug

CPU Register Set

9. Memory Window

10. Graph Window

11. Mixed Mode Display

12. Assembly Single Step

13. GEL - General Extension Language

ONoabkhwbdE

The step-by-step approach for Lab3 will show how to do the following:

e Open Code Composer Studio

Create a F2833x - Project, based on C

o Compile, Link, Download and Debug this test program
e Waitch Variables

e Continuous run and single - step mode

e Use of Breakpoints

o Use of “Real - Time - Debug” - mode

o View registers

¢ Mixed Mode (C and Assembler Language)

e General Extension Language (GEL)

Before we start to go into the procedure for Lab3 at the end of this chapter, let us discuss the
individual steps using some additional slides.
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Start Code Composer Studio Version 4

Once you or your laboratory technician have installed the software tools and the correct Emulator
driver for CCS4.1, you can start Code Composer Studio by simply clicking on its desktop icon. If
you get an error message, check the correct USB connection of the target board. If everything
goes as expected, a message will pop up, asking you to select a “workspace”. Code Composer
Studio stores your projects in a folder called a workspace. Now you have to choose a workspace
folder for this session.

You might have to ask your teacher, which folder you should use in your classroom. For this
tutorial, I assume that we store the projects in “C:\DSP2833x_V4\labs”.

1. Start CCS Version 4 @

. Code Composer Studio stores your projects in a folder
called a workspace.
» Select a workspace folder for this session, e.g.:

C:\DSP2833x_V4\labs

& Workspace Launcher

Select a workspace

Code Composer Studio stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: [C\D5P2833_Vd\abs

[™ Use this as the default and do not ask again

0K Cancel

Next, a “welcome” window will appear. As the name suggests, this window shows you essential
menus for CCS, such as “Getting Started”, “Examples”, “What’s new” and “Device Information”.
Although all these information might be very interesting, we will concentrate on our task to
generate our first project from scratch.

Later you can always return to this welcome page (= Help =» Welcome).
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Code Composer Studio Version 4 - Step by Step

Let us now create our first project. Click on File = New =» CCS Project and enter “Lab3":

2. Create a F2833x - Project

File = New =» CCS Project

location , as shown below:

& New CCS Project

B3|
CCS Project

Create a new CCS Project.

Project name: [Lzbd]

¥ Use defauit location

Location: |C:/DSP283%_Véabs/Lab3

Mext > Eiriist

Cancel

give your project a name “Lab3” and select the default

&

This step is quite similar to most of today’s design environments with one exception. Because
CCS4 is also used for C6000, C5000, MSP430 and ARM processors, we have also to define the
project type, in our case “C2000”:

3-9

2. Create a F2833x - Project

Select Type of Project: C2000

) New CCS Project

Selecta type of project

Select the platform and corfigurations you wish to deploy on

Project Type: [C2000

Configurations

I~ Show All Project Types

& New CCS Project

Additional Project Settings

Define the inter-project dependencies, if any.

Lt Projects | C/Cs-+ indeer

Referenced Projects

&
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We do not use any inter-project dependencies so far, so click “Next” twice.

Now we have to set the project properties according to the following Slide 3-11.:

g 2. Create a F2833x - Project @

Setup Properties: — o=r=m=
CCS Project Settings »
Select the CCS project settings &
Output Type : Output type: | Exccutable =l
[~ Project settings
E_X ecu tab l € Device Variant [Tussaocomex =] [Tms320r28335 o woe |
Device Variant: Devio Endormess: [ ]
Code Generation tools: | T1v5.2.3 | Moe.
TM8320F2$335 . = =
Code Generation Tools: | usecommers

Tlv 5.2.3 Runtime Support Lbrery: [ERETTRTENERIE
Linker Command File: [ Trestasen fesetlyry pries
28335 RAM Ink.cmd &
Runtime Support Library: :g:;f;jg:::L:j;i:msvemmE"Mm) L=l | e
rts2800 fpu32.lib
Target content:
None

<Back oo |[ Eush | Cancel

3-11

Close the project setup by clicking on “Finish”. We are almost done. Cancel the “welcome”
window to show the project layout. All C code based programs need a system stack. We have to
define its size:

2. Create a F2833x - Project @

Setup C- Stack Size:

 Rightclick at “Lab3” and select “Properties”

File Edit ‘iew Mavigate Project Tools Target
NSRS
£ =8
e

== Lab3 [Active - Debug]

=) % Includes

‘ @ C:/Program Files/ Texas Instrument.

-] 28335_RAM_Irk cmd

 Goto category:
e C/C++ Build, C2000 Linker, Basic Options
» Set C system stack size: 0x400
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The following Slide 3-13 shows the setup for the stack size. The selected size of 0x400 is a first
“rule of thumb” number. Later we can be more specific about the stack usage of code examples.

é 2. Create a F2833x - Project @

B Propestics for Labid Hi=E
Freetieriet TG+ Duild
Actrve configuraion
Preject Type: [0 |
Contgurstion. | ety ﬂl‘
Corfiguraton Setings
Tool Sergs | Buts Setings | Butd Siece | Emor Parvem | By Parser | Ererorment | oo |
L2 e Dy =1 e fie. o [Leb1o” fromen: I
I " rput oref sty soctens iated e e (-mig i, ) [Looimo Tome_ |
S et ack e [atack_sa, k] [onali]
< heas_sae. tesa)
[k | B |
==

Do not change the remaining parts of this property window.

Close the window by clicking “OK”.
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Write C - code

Next, write the source code for your first application. The program from the slide below is one of
the simplest tasks for a processor.

unsigned int k;
unsigned iInt i;

void main(void)

while(l)
for(i=0; i<100; i++)
{
k = i*i;
}

}
+

The code example consists of an endless while(1) - loop, which contains a single for - loop -
instruction. In that for-loop we:

e increment variable i from 0 to 99,
calculate the current product of i * i and
store the product temporarily in variable k.

It seems to be an affront to bother a sophisticated Digital Signal Controller with such a simple

task! However, we want to gain hands-on experience of this DSC and our simple program is an
easy way for us to evaluate the basic commands of Code Composer Studio.

3. Write a C — code file

. Write a C-Source Code :

=2 File New =»Source File

& New Source File

Creats a new source file c
=
Source Folder: [Lab3 Browse
Source File:  [main.c . “ . .
In ,main.c”, enter this code:
1 mnsigned int k;
o el ; unsigned int i;

4 void main(void)
5

while (1)

€

for (i=0:; i<100: i++)

F2833x - Program Development Tools
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Linker Command File

Before we continue with our project, let us first discuss why we added the file
“28335_RAM _Ink.cmd” to our project (see Slide 3-11). This file is used to control the “Linker”.

The “Linker” puts together the various building blocks we need for a system. This is done with
the help of a so-called “Linker Command File”. Essentially, this file is used to connect physical
parts of the DSP’s memory with logical sections created by our software. We will discuss this
linker procedure later in detail. For now, we will use a predefined Linker Command File
“28335_RAM _Ink.cmd”. This file has been provided by Texas Instruments and is part of the CCS
Version 4 support package.

C - Compiler Sections

When we compile our tiny code from Lab3, the C - compiler will generate 4 so-called “sections”.
These sections cover different parts of the object module, which must be “linked” to physical
memory. Our four sections are:

o text This section collects all assembly code instructions

o .ebss The section covers all global and static variables

e _cinit This section is used for initial values

e stack The stack memory for local variables, return addresses, parameters
C — Compiler Sections @

Global vars (.ebss) Init values (.cinit)

unsigned it k=103 ;
unsigned Int-i; 7
void main(void)

{ Local vhriables,
while(l) System Context
[ e— (.stack)

For(i=0;i<100;i++) ™
{
k=i*i;
3 — Code (.text)

The linker will connect these sections to physical memory. For this task we pass information to
the linker with the help of “Linker - command - files” (extension *.cmd). But before we look at
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the details of this procedure, let us finish the C compiler sections. As you can probably guess,
when we use a slightly more complex program than Lab3, the C compiler will generate more
sections. The following slide will summarize all possible C sections:

s Compiler Section Names 2

R Initialized Sections

Name Description Link Location

.ebss global and static variables RAM

.stack stack memory area RAM (lower 64K)
.esysmem heap memory for dynamic memory allocation. RAM

Name Description Link Location
text code FLASH*
.Cinit initialization values for global and static FLASH*

variables

.econst constant variables (e.g. const int m=3;) FLASH*

.switch tables for addresses in “switch — case” lines FLASH*
.pinit tables for global constructors (C++) FLASH*

Uninitialized Sections

Note: (*)During development initialized sections could be linked to RAM
since the emulator can be used to load the RAM

Linking Sections to Memory

The following Slide (3-17) gives an example on how we could link the four sections from Lab3
into parts of physical memory. For a standalone embedded system, all constants, initialization
values and code must be stored in non-volatile memory, such as FLASH. Un-initialized data
(variables) are linked to RAM.

Note: Our lab “lab3” will be based on volatile memory usage only, so the following explanation
is a more generic one.
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&

Placing Sections in Memory

Memor .
y Sections

(0X400) ST -

(0x400) | TTm=-_

.stack

S ——

(0x40000) -

~ -
-~
-~
-~
-~
-~
~ -
-~

text

Linking @
e Memory description
e How to place Software

Sections into Memory

name.cmd

.0bj —| Linker .out

.map

3-18

The procedure of linking connects one or more object files (*.obj) into an output file (*.out). This
output file contains not only the absolute machine code for the Digital Signal Controller, but also
information used to debug, to flash the controller and for more JTAG based tasks. NEVER take
the length of this output file as the length of your code! To extract the usage of resources we
always use the MAP file (*.map).
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Now let us inspect the linker command file “28335_RAM_Ink.cmd”. Basically the
two parts, “MEMORY” and “SECTIONS”.

file consists of

“MEMORY” declares all available physical memory of the device. The declaration is split in

“PAGE 0” — for code memory and “PAGE 1” for data memory.

Please recall that the F28335 is a Digital Signal Controller and that one of the properties of DSPs
is to have a “Harvard”-Architecture, which has two memory spaces, one for code and one for

data.
MEMORY
n .
BAGE 0 : Memory
/% BEGIN is used for the "boot to SARAM" bootloader mode phySICal SpaCeS
BEGIN : origin = 0x000000, length = 0x000002 /=
RAMMO : origin = 0x000050, length = 0x0003B0
REMLO : origin = 0x008000, length = 0x001000
RAML1 : origin = 0x009000, length = 0x001000
RAML : origin = 0x00A000, length = 0x001000
EEML3 : origin = 0x00B000, length = 0x001000
ZONETA : origin = 0x200000, length = 0x00FCO0 i*
SECTICNS
{
/# Setup for "boot to SARAM" mode:
The codestart section (found in DSP28_ CodeStartBranc
H . re-directs execution to the start of user code. */
SeCtlons- codestart : » BEGIN, PAGE = 0O
ramfuncs : > RAMLO, BAGE = 0
ConneCt .Cext : > RAMLIL, PAGE = 0O
H .cinit : > RAMLO, PAGE = 0O
LOg|Cal b|OCkS to .pinit : > REMLO, BAGE = 0
phyS|Cal Spaces .awicch : > RAMLO, FRGE = 0
.stack 1 > RAMMI, BAGE = 1
.ebs= : > REML4, PAGE = 1
.econst : » RAMLS, PAGE = 1
. eSySmem 1 > RAMMI, BAGE = 1

&

-19

When you inspect the file, you will find that our sections are actually allocated in:

e .textis allocated in code address space 0x9000 (RAML1)
e .cinitis allocated in code address space 0x8000 (RAMLO)
e .ebssisallocated in data address space 0xOC000 (RAML4)
e stack is allocated in data address space 0x0400 (RAMM1)

Close the file “28335_RAM _Ink.cmd”, when you are done.
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Build the active project

Now let us resume or lab and build the machine code. This step includes the compilation of all
source code files (C and Assembler) and the linking of all modules and libraries, which are part of
the project, into a single output file. This file contains a lot of information, including the machine

code for all sections.
=> Project = Rebuild Active Project

And watch the tools output in the console window:

4. Build the Active Project 2

e D> Project = Rebuild Active Project
« Watch the tools running:

(zl I H; E-rj-=0
C-Build [Lab3]
#*%% Build of configuration Debug for project Lab3 ##*#*% ;I
C:\Program Files\Texas Instruments_4l\ccsv4hurilshgmakehgmake -k all
'Building file: ../main.c'
'Invoking: Compiler'
"C:/Program Files/Texas Instruments_41/ccsv4/tools/compiler/c2000/bin/cl2000" -
-silicon version=28 -g —-include path="C:/Program Files/Texas
Instruments_41/ccsv4/tools/compiler/c2000/include” --diag warning=225 --large_memory model -
-float_support=fpu32 —-preproc_with_compile --preproc_dependsncy="main.pp” "../main.c"
'Finished building: ../main.c'
'Building target: Lab3.out'
'Invoking: Linker'
"C:/Program Files/Texas If]st.IJHESCE_QJ/CCSV&/tDDlS/CanilEI/CZOOO/bin/ClEOOO" -
-silicon_version=28 -g —-diag_warning=225 --large memory model —-float_ support=fpu32 -z
-m"Lak3.map"” --stack_size=0x400 --warn_sections -i"C:/Program Files/Texas
Instruments_41/ccsv4/tools/compiler/c2000/1ib" —i"C:/Program Files/Texas
Instruments_41/ccsv4/tools/compiler/c2000/include” --reread_libs —-rom_model -o "Lab3.out”
"./main.obj"™ —-1"rts2800_fpu3Z.lib" "../ZEBES_RAM_lnk.CI(d"
<Linking>
'Finished building target: Lab3.out"
Build complete for project Lab3 =

3-20

Hopefully you have the same console output as shown in Slide 3-20 above. If you have error
messages or warning, both in red colors, you will have to find out what went wrong. In most
cases, not always, the error comment gives you an indication about the cause of the
error/warning.

And, you still have the option to ask your teacher!

Please do NOT continue with the next steps in case of errors/warnings!
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Create a new Target Configuaration

Before we can download the machine code into the F28335, we have to define the “target
configuration”.

=>» Target = New Target Configuration

Type a name for the target configuration file in box “File name”. You can use any name here but
it makes sense to indicate the JTAG-emulation interface, which we will use for the download
later. In case of the Peripheral Explorer Board we use the XDS100V2, so let us call the file
“F28335_XDS100V2. The suffix “.ccxml” will be added automatically.

« =» Target = New Target Configuration
%) New Target Configuration x|
Target Configuration
Create a new Target Configuration file
File name: IFZEBES_XDS1DDV21
. ™ Use shared location
Basic -
Location: [/Lab3/Debug Browss |
General Setup
This section describes the general configuration about the target.
Connection I'I'Ems Instruments XDS5100v2 USB Emulator
Board ar Device |WDE Filter text (7} Cancel
[ TMS320F2809 =
O TMs320F2810
[0 ™ms320F2811
[0 Tms3z20F2812
O ™Ms320F28232
[0 ™ms320F28234
O TMs320F28235
[0 ™mS320F28332
[0 ™ms320F28334 _|
TMS320F28335
[ TM5320R2310 =
3-21

In the window that appears, select the emulator “Texas Instruments XDS100v2 USB Emulator”
via the “Connection” pull-down list and select the “TMS320F28335” device checkbox.
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Download code into the controller
Now it is time to download the code into the F2833x.
=> Target =» Debug Active Project

This command is also available on the green bug:

Target Toolz  Scripts

EHE SR A

-

DEBUG

This button combines the following “single action” commands:
¢ Rebuild Active Project
e Connect Target

e Load Program

6. Download and Debug @

. 9 Target & Debug Active Project

) Dty - s - Canin Conmpasaer S (oot
Be B Yow Nowms Poec Tege Juk Sorn Redw B - =
i || B0 | B[Sl 03] © Do (I CCe

I D e e b=l el w = mrEen
i 0% 100 LS mtor_(LC8ex [Pocject Oatag Saeman| = | Ve | S | Tpe |fomu |

£or (1505 Seionr 144

A blue arrow should now point to the “for” — line in code file “main.c”. This is an indication that
the machine code has been downloaded properly into the F28335.
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Note: The automatic procedure of connecting the target, download code and run the code to the
entry point of main can be controlled by the project properties. Right click at the project “Lab3”
and select “Properties”. In the “CCS Debug” category, go to the “Target” properties and verify,
that “Run to main” on a program load is enabled. Next, close the property window.

: 6. D load and Deb
@ ownload and Debug @

* Properties of Project “Lab3":

P Propesties for Lah3
Frettaime | GO Debug

Buiders L Man | 43 Debgper == Torgat | 6 Scurce | 7 Common |
C/Coe Buid [ Ol Dol Ostirt. || [ | Disabin

o —— | -

e inceame | ¥ Enale €10 functon e feqses

|

: I Hiak the target bafors any debugger sccasi

L

= Er oy rrat K

~ Auks Pl Cpfiors:

: ¥ Ona program iood orreatnt
| Oname

|emto e

hﬂuml
(o]

I

Debug Perspective

Code Composer Studio Version 4 allows inspecting a project from different perspectives. All
available perspectives are show in the top right corner of CCS. You can always change your
perspective of looking into the project. There are at least two perspectives, “C/C++” and
“Debug”. For the following tests please make sure that you have selected perspective “Debug”:

=181 x]
7 | %5 Debug HgjC/C+=

| e T Y S
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Test the Code

Now that we have successfully downloaded our code into the target, we can perform some basic
test commands.

RESET CPU

The most important hardware command for the target is “RESET”. This command will always
force the device to a default RESET condition, including all internal peripheral units.

=>» Target =» Reset =» Reset CPU

7. Test the code 2

. Hardware Reset:

= Target = Reset = Reset CPU
| —)

=2 Disassembly ( etext + c3FE33d) X

=
|Errter|0c:ati0n here =] | [c) | S | ”g =
W Ox3FF9CE: 2BRDO00E MOV BSE, #0x0006 -~
0x3FFSD0: 561F SETC OBJMODE
O0x3FF9D1: 5616 CLRC AMODE
O0x3FF9D2: Sala SEIC MOMIMAP
OxX3FF9D3: 2940 CLRC PAGEQ
0x3FFaD4: TelF0000 MOV DP, #0x0000
0x3FF9D&: 2802 CLRC oM
O0x3FFaD7: FF&9 SEM a
N

* Restart Code:
= Target = Restart
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A new window, the “Disassembly Window” will open. This window shows the machine code that
will be executed in the next clock cycles. However, the JTAG — Emulator has frozen the
controller, so that we can take our time to inspect all parts of the CPU and the peripherals. The
blue arrow shows the current position of the Program Counter (PC), which is now loaded with the
hardware - reset address Ox3FF9CE in Boot-ROM. The purpose of register “PC” is to always
point the next machine code instruction to be executed.

We will not discuss the content of the Boot-ROM now; let us postpone its details for a later
chapter.

Restart CPU
Another important command is
=> Target =» Restart

This command is often used directly after a RESET command. Its purpose is to bypass the Boot —
code and to load the Program Counter (PC) directly with the “entry point address” for the code.
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This entry point address can be specified in the project options. For C-language based projects the
default address is the environment preparation function “_c_int00” (from library rts2800_fpu.lib”

However, because we have enabled the auto run option to “main()”, the restart command will run
through “_c_int00” and stop at the beginning of “main()”. If this auto run option would have been
disabled, we could use =» Target = “Go to Main” as a 3" command.

The Watch Window

To watch the program’s variables, we can use a dedicated window called the “Watch Window”.
This is probably the most used window during the test phase of a software project. It is good
engineering practice to carefully test parts and modules of a software project. For an embedded
system we need to ‘look’ into internal parts of the controller, such as variables and function
stacks and monitor their changes.

Here the Watch Window is of great use. Instead of hitting the ‘run’ - key F8 and hoping that the
software behaves as expected, it is much better to test it systematically. That means:

o Predict, what will happen in the next instruction
e Single step the critical code instruction

e Monitor the variables of that code snippet and compare the results with your
expectations.

e Proceed with the next line under test.

8. Watching variables @

. Ifnot already open, open a Watch Window: = View = Watch

e To inspect the global variables ‘i’ and ‘k’ we have to add this
variables manually. This can be done inside window ‘Watch(1)'. In
the column ‘name’ we just enter ‘k’ and in the second line ‘i’.

< Another convenient way is to mark the variables inside the source
code with the right mouse button and then select “Add Watch
expression”

« In column “Format” we can change the data format between
decimal, hexadecimal, binary, etc.

sl N e
Name | Walue | Address | Type I Format

-k 0 (0000C009@Data unsigned int Natural

[E 3088 (<0000C008@Data unsigned int Natural
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Note that the physical addresses for ‘i’ and ‘k’ in column “Address” are shown as 0xC009 and
0xCO008 respectively. Can you explain why these two addresses have been used? (Answer: The
linker command file, which we inspected earlier, allocated section .ebss (global variables) to data
memory “RAML4” at address block 0x00C000.)

3-24 F2833x - Program Development Tools



Code Composer Studio Version 4 - Step by Step

Code Step Comands

Another useful part of a debug session is the ability to debug the code in larger portions and to
run the program for a few instructions. This can be done using other commands in the single-step
group. In the “Debug” perspective, perform:

9. Perform a Single Step Debug @

» Perform a single step of the target - code:
= Target =» Step Into (or use function key “F5")
* Watch the current PC (blue arrow) and the values of
variables ‘i’ and ‘k’ in Watch Window while you single

step the code !

* More debug - commands are shown at the following
slide:

tSUspended)
at main .c:8 (005083

Source Step Over Assembly Single Step
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When you would like to run the code through a portion of your program that you have already
tested before, a “Breakpoint” is very useful. After the “Run” command, the JTAG debugger stops
automatically when it hits a line that is marked by a breakpoint.

é 10. Set a Breakpoint 2

» Set a Breakpoint:
— Place the Cursor in Lab3.c at line: k=i *i;
— Click right mouse and select “Toggle Breakpoint”
— the left hand side of the line is marked with a blue dot to indicate an
active breakpoint.
— A 2d gption is to use a left mouse double click at the grey left hand side
of window “Lab3.c” to toggle the breakpoint.

Reset the Program
= Target = Reset = Reset CPU
= Target = Restart

Perform a real time run
= Target = Run (or F8)
The F2833x stops after hitting an active breakpoint

repeat ‘Run’ and watch your variables
* remove the breakpoint (Toggle again) when you're done.

3-28
10. Set a Breakpoint (cont.) 2
:. wvoid main(void)
=1 : | ¢ for (i=0; i<100; i++)
7-:
blue and ek
enabled dot: P
X . of PC
active Breakpoint
3-29
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Real - Time Debug Mode

A critical part of a test session is any interference between the control code and the test functions.
Imagine, what would happen with PWM output lines for power inverters, if we would just place a
breakpoint in a certain point in our code. If the processor hits the breakpoint, the execution would
stop immediately, including all dynamic services of the PWM lines. The result would be: fatal,
because a permanent open switch will destroy the power circuits.

The best solution would be to have an operating mode, in which the control code is not disturbed
at all by any data exchange between Code Composer Studio and the running control code. This
test mode is called “Real - Time - Debug”. It is based on a large set of internal registers in the
JTAG - support module of the F2833x. At this stage we will not discuss the internal functionality;
we will just use its basic features.

It is important to delete or disable all breakpoints in a CCS - session, before you switch ON the
Real - Time - Debugger. So please make sure, that no breakpoints are left from previous tests!

11. Real — Time - Debug @

Reset F2833x:
= Target = Reset = Reset CPU

Watchdog Timer:
always active after a Reset
» if not serviced, it will cause another Reset after 4.3
milliseconds.
* normally, watchdog is cleared by “key’-instructions
» forthe first lab, let us just disable the watchdog:
= Scripts = Watchdog =» Disable Watchdog

Start “Real — Time — Debug”:
= Scripts = Realtime Emulation Control =»
Run_Realtime_with Restart

3-30

To switch into Real - Time - Debug, it is good practice to first reset the device. This step ensures
that all previous core and peripheral initialization is cancelled.

We have not discussed so far the internal watchdog unit. This unit is nothing more than a free
running counter. If it is not serviced, it will cause a hardware reset. The purpose of this unit is to
monitor the correct flow of control code. There are two dedicated clear instructions, which are
normally executed from time to time, if the code is still running as expected. If not, because the
code hangs somewhere, the watchdog will bring the device back into a safe passive state. It
operates similar to a “dead man’s handle” in a railway locomotive.

We will discuss and use the watchdog in detail in chapter 5. However, the watchdog is active
after power on, so we cannot neglect it! For now, we can use a CCS script command to disable
the watchdog. We would never do that in a real project!
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To use “Real - Time - Debug” perform:
=>» Target =» Reset = Reset CPU
=> Scripts =» Watchdog =» Disable Watchdog
=> Scripts =» Real time Emulation Control =» Run_Realtime_with_Restart

Now the code is running in real-time. The new feature is that we can interact with the device,
while the code is running. To practice this:

e In the upper right-hand corner of the watch window, click on the white down-arrow
and select “Customize Continuous Refresh Interval”. Change the *“Continuous
Refresh Interval” to 1 second instead of the default 5 seconds.

e In the upper right-hand corner of the watch window, click on the yellow arrows
rotating in a circle over a pause sign to enable continuous refresh mode for the watch
window.

The content of the watch window is now updated frequently. The JTAG - controller uses cycles,
in which the core of the device does not access the variables to “steal” the information needed to
update the window. However, the USB-JTAG emulator is too slow to update the watch window
in the same frequency as our F2833x executes the for-loop. That is why we do not see each
increment of variables ‘i’ and ‘k’.

11. Real — Time — Debug (cont.) @

Continuous
Refresh

» Enable Continuous Refresh

* Inthe “menu” open “Customize Continuous Refresh Interval”
and change the “Continuous Refresh Interval” to 1 second.

e The variables k and i are updated in the background, while
the code is running

e The execution speed of the control code is not delayed by
monitoring variables.

¢ Note: The USB — emulator is too slow to update the watch
window as fast as the F2833x executes the for-loop. That is
why you will not see each iteration of i and k.

= GEL = Realtime Emulation Control = Full_Halt
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When you are done, you should stop the real - time test by:

=>» Scripts =» Real time Emulation Control =» Full_Halt
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Note: the test mode “Run_Realtime_with_Reset” will first perform a reset followed by a direct
start of the device from its reset address. The device will follow its hardware boot sequence (see
Chapter 15) to begin the code execution. Since the Peripheral Explorer Board sets the coding pins
to “Branch to FLASH” by default, it would start code stored in FLASH. The problem is, that so
far we have not stored anything in FLASH (we will do this in Chapter 14). By using
“Run_Realtime_with_Restart”, we force CCS to place the program counter at the start address
of our project in RAM (a function called “c_int00™) and to start from this position.

CPU Register Set

When you are more familiar with the F2833x and with the tools, you might want to verify the
efficiency of the C compiler or to optimize your code at the Assembly Language level. As a
beginner you are probably not in the mood to do this advanced step now, but a brief look would
not be amiss.

Open a register window:

= View =» Registers

12. CPU Register Set @

Name [ Value | -

« Allows to monitor all internal = &% Cow Fegeiers
CPU registers o st
« Register STO combines math
status flags, such as:
e C (carry)
* Z (zero)
* N (negative)
« V (overflow)
* SXM (sign extension mode)
* OVM (overflow mode)
e TC (test control flag)
¢ PM (product mode shifter)
* OVC ( overflow counter)
* Register ST1 combines CPU
control flags.

0x000015F%
OxFFFFFFFF
0x00090000
0x00000000
0x0000FFFF
0x00000000
0x00000000 —
0x00000000
0x00000000
0x00000000
0x00008015
0x009085
0x009060
0x0080

0x0

Oxl

0x0

0x0

0x0

0x0

0x0

0x0

0x0

0xCROS
0x0300 hd
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When you expand the plus signs, for example for register STO, you can inspect details of a
particular register more in detail. At this early stage of the tutorial it is not important to
understand the meaning of all the bit fields and registers, shown in this window. But you should
get the feeling, that with the help of such windows, you can obtain control information about all
internal activities of the device.

There are two core registers, STO and ST1, which combine all core control switches and flags of
the CPU, such as carry, zero, negative, overflow, sign extension mode, interrupt enable and so on.
An inspection of these flags and bits allows you to immediately monitor the status of the CPU in
a certain spot of code.
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The 32-bit registers ACC (“accumulator™), P (“Product”) and XT (“eXtended Temp”) are the core
math registers of the fixed - point arithmetic unit.

The 32-bit registers XARO to XAR7 are general purpose registers, often used as pointer registers
or auxiliary registers for temporary results.

The register PC (“Program Counter”) points always the address of the next machine code
instruction in code memory. The register RPC (“return program counter”) stores the return
address of a function, which has called a sub-routine.

Watch Memory Contents

Let us open another control window, the “Memory Window”. This window allows us to inspect
any physical memory locations of the device, including RAM, FLASH, OTP and Boot - ROM.
Since the core of this device is a Digital Signal Processor, we have always to remember that there
are two memory spaces, code and data. To inspect variables, we have to select “data space”. For
machine code instructions inspection we have to look into “code space”. The selection is made in
the center box at the bottom of this window.

13. Memory Window @

— make sure to inspect data space (top right hand side selection box)
— enter address &i in the top left corner box:

e the current value in memory N
. . . . i - Jaa - |
location of variable i (and k) is 2 == |
displayed 2 A i

|Hex 16 Bit - C Style Hex =

-

* change the display type from

“Hex — 16 bit” to “16 Bit 0x0000C008 k
UnSIgned Integer" 0x0000C009 0O=x0190 0x0000 0x0000
O0x0000C00C OxF658 0x9183 0xD1F2
Ox0000CO0F OxBAS4 0x0CO00 0x0000
° Change the d|Sp|ay type |nto “16 0x0000C012 O=x0003 0x0000 Ox0000 =
Bit Binary”
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The right-hand side selection box allows us to specify the display mode of the 16-bit memory
location in different form, such as:

e Hexadecimal
e Integer, signed and unsigned
e Binary
e Float
e Character
The number of memory windows is not limited, you can open as many as you like!
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Graphical View

A unique feature of Code Composer Studio (CCS) is the ability to display any region of memory
in a graphical form. This is very helpful for inspection of data, such as sampled analogue signals.
We can display such memory values as raw data on a time - axis or even better, we can display
the samples a frequency axis. In the 2™ option CCS is performing a FOURIER - transform,
before it displays the data.

Let us inspect this graph feature. The BOOT-ROM contains a sine - value lookup table of 512
samples for a unit circle of 360 degree. The data format is 32-bit signed integers in fractional
12Q30 - format. The start address of this table is Ox3FEQ0O.

Open a graph window and enter the properties from the left hand side of Slide 3 - 34:

14. Graph Window @

Graph Properties (%]
Fro Value

— View of sine-value look-up table

. ‘Acauiston Buffer Sze | 512
in BOOT-ROM (OX3FEOOO) Dsp Data Type 32 bt signed integer
. . Index Increment 1
— 512 values (32-bit signed, 12Q30) a Ve E)
Sampling Rate HZ 1
Start Address (x¥e000
1 Display Froperties
Puis Display ] tue
Data Plot Style Line
Display Data Size 512
Grd Style Major Gad
[ ] Magnitude Display Scale_| Linear
Time Display Unit sample
B Msc
B - ‘ m“"@«*ﬁ s ‘ M Use De Value For Graph  |[] falee
= 3 E E
09
05
01
03
27
1]
] 100 200 300 400 5008
G 2

Import | Export | oK | Eancall
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Optionally, you can open a second window to show the fast FOURIER transform (FFT) of the
sinusoidal lookup table in Boot — ROM.

Open a graph window and enter the properties from the left hand side of Slide 3 - 35:

é 14. Graph Window @
Graph Propories | x]
— View of sine — value look — up table m:::“w ; 'T l
in BOOT - ROM (0x3FE000) Do v Toe Rbtwadrioge
— 512 values ( 32 - bit signed, 12Q30) A T
Soral Type Fesl
Stan Address DeIFEDOD
Diaplay Proguetien
Aoan Duclay ] e
Data Pt Style Lre
Feoguency Duplay Ure  Hz
St Shje Wager G
Magrtucde Duclay oo Lresr
[ = f",m.w,ﬂ =
EIE I .| t:;""@@’ iR ;‘l P FFT Window Fundtion  Hamming
6
5
O
1
1
. —
(1] 01 02 03 04 o = =
3-35
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Mixed Mode C and Assembly

An important test method for inspecting both C and the resulting assembly code from the C -
compilation is called “Mixed Mode” - display. This option allows us not only to inspect and
verify the device steps both on C high-level language, but also on the device native environment
assembly language.

é 15. Mixed Mode Visualization @

* To view both the C — source - code and the resulting

Assembler — Code:
— click right mouse inside window “Disassembly” and enable “Show
Source”
— Both the C-source code (bold) and the Assembler Instruction Code
generated by the C - Compiler (grey) are displayed

Enter location here j ”E e | S | ”E B 7
-

for| (i=0; 1<100; i++)

0x00907F: SB
10 k = i*i;
C$DWSLS main$3$B, C3L2, C3DWSLS main$23E:

0x009080:

Jt;

Although this test method is not always required, especially not at the beginning of a tutorial, it
allows us to benchmark the efficiency of the C compiler.

Also later, when we have to use assembly optimized libraries and to design time critical control
loops, it will be important to optimize programs. For high speed control loops, for example in
Digital Power Supply, where sometimes the control loop (e.g. sample measurement values,
compute new output values and adjust PWM - outputs) runs at 500 kHz or even at 1 MHz, we
deal with time intervals of 1/IMHz = 1ps. Assuming that the device runs at 150MHz (= 6.667
Nanoseconds clock period), we can execute just 150 machine code instructions in such a loop. In
such circumstances an option to monitor a code flow on assembly language level is very helpful.
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Assembly Single Step Mode

In mixed - mode visualization of C - modules we can perform test steps both on C and Assembly
Language level. Code Composer Studio supports the 2™ test mode by two more icons (green
arrows in the “Debug” and “Disassembly” windows):

o Assembly Single Step
o Assembly Step Over

16. Assembly Single Step @

Current

Current

C - line ASM -
Instruction
6 IEnter location bére j ”Eﬁk?_ ‘@ |
wlé x{fo: (i=0; i<100; i++) H?/L{f /

k= i%i; -

single step

: - 1 _args_main() at args_main.c:43 (005060
9] Texas Instruments XDS 100v2 USB Emulator_0/C2oc (16:50:34)
| Texas Instruments XDS100v2 USB Emulator_0/C2%oc: CIO (16:50:34)
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If you use “Assembly Single Step”, the code is executed machine code line by machine code line.
The dark blue arrow in the “Disassembly” window marks the next following assembly line. The
light blue arrow in the C-code window (“main.c”) remains at the corresponding C - line, as long
as we deal with the assembly results of that line.

At this point it is not important to understand what happens in this assembly code snippet. We
will deal later with assembly coding and optimization. However, it is never a fault to question
your teacher!

For Assembly Language freaks only:

Here is an explanation of the first C-line: for( i=0; i<100; i++)
MOVW DP #0x300 ; sets the direct address pointer DP to address 0xC000
; 0x300 left shifted 6 times gives 0xC000
MOV @8,#0 ; loads constant 0 into address 0xC008 (which is “i”)
MOV AL,@8 ; read value from address 0xC0008 into register AL
CMPB AL,#100 ; compares AL against constant 100
SB main, HIS ; short branch (SB) to the beginning of main, if AL was “Hlgher

; or Same (HIS)”
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GEL General Extension Language

The General Extension Language (GEL) is a high-level script language. Based on a *.gel — file,
the user can expand the features of Code Composer Studio or perform recurrent steps
automatically.

617 GEL - “General Extension Language” @

* GEL = high level language, similar to C

* Used to extend Code Composer Studio’s features
» to create GEL functions use the GEL syntax

* load GEL-files into Code Composer Studio

* With GEL, you can:

— access actual/simulated target memory locations
— add options to Code Composer’'s GEL menu

* GEL is useful for automated testing and user workspace
adjustment .

» Startup GEL files defined in the target configuration file
will be automatically loaded when a debug session is
started

» Additional GEL files can be loaded in the CCS from the
'GEL Files' dialog (via 'Tools->GEL Files' menu)

By default, startup GEL - files defined in the target configuration file are automatically loaded
when a debug session is started.

To open and inspect the default GEL - file, select:
= Tools =» GEL Files

Right click at file “F28335.gel” and select “Open”. Inspect the file to get a view of the syntax of
this GEL language.

For example search function “OnReset”. This function will be executed every time we perform a
command =» Target =» Reset =» Reset CPU.

OnReset(int nErrorCode)
{
C28x_Mode();
Unlock _CSMQ);
ADC_Cal();
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This function itself calls 3 more functions to switch the device into C28x operating mode, to
unlock a code security module (CSM) and to calibrate the internal Analogue to Digital Converter
(ADC).

él? GEL - “General Extension Language” @
;)Tools =2 GEL files

ype fiter text GEL Files (TMS320C281) (7)
: On-<Chip Flash
Generic Debugger Options Scri [Status |
i GEL Files f28335.gel Success

C2%0c Debugger Options
£ Memory Map

Right-click in the view and select ‘Open’ to inspect the
default GEL-File “F28335.gel”

Example Function: “OnReset”: OnReset (1t nExzorCode)

{
c28x_Mode () ;
Unlock CSM{);:
ADC_Cal():
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Lab 3: beginner’s project
The following procedure is a summary of the steps, which we discussed in the previous part of

this chapter. The following procedure will help you to build your first project for the F2833x
device under Code Composer Studio Version 4.1.

Objective
The objective of this lab is to practice and verify the basics of the Code Composer Studio

Integrated Design Environment. The following procedure will summarize all the steps discussed
in this chapter.

Procedure

Open Files, Create Project File

1. To open Code Composer Studio Version 4.1 click the corresponding desktop icon:

2. Next, select a workspace. Ask your teacher about the correct directory of the laboratory PC.
The example below uses the folder “C:\DSP2833x_V4\labs”

@Workspaoe Launcher

Select a workspace

Code Composer Studio stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: |C-\DSP2833_V4\labs

™ Use this as the defautt and do not ask again

3.
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In the following window, select “C2000” for the project type.

& New CCS Project

Select a type of project
Select the platform and corfigurations you wish to deploy on

& New CCS Project

Additional Project Settings
Define the interproject dependencies, f any.

& New CCS Project
CCS Project Settings
Select the CCS project saftings.

Executable

[Tusacon ] [smiross x| Mee. |
e I
-
focr
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4. Define the size of the C system stack. In the project window, right click at “Lab3” and Select
properties:

Includes

L@ C:/Program Files/Texas Instrumert
-5 28335_RAM_Ink cmd

In category “C/C++ Build”, “C2000 Linker”, “Basic Options” set the C stack size to 0x400:

& Properties for Lab3

Info
- Bulders
C/C++ Documentation
C/C++ File Types
- C/C++ Indexer
- CCS Build : ;
-CCS Debug
Project References
Refacorg Hsiory . L Funtine Moda Options
¢ (2 Optimizations:
| (2 Eriry/Bxit Hook Options:
(% Feedback Options: G200l
2 Library Function Assumptions:
~( Assembler Options 7
-(2 File Type Specfier
2 Directory Specifier:
(2 Defautt File Edensions:
i Command Files:
-5 C2000 Linker
-2 Command File Preprocessing
(2 Diagnostics:
(2 Flle Search Path:
2 Linker Output:
(2 Symbol Management
-2 Runtime Environment
2 Linktime Optimization
2 Miscallansous:
(7]

Note: The stack memory is used by the compiler to store local variables, parameters and
the processors context in case of hardware interrupts. It is our task to specify a certain
amount of memory for this purpose and 0x400 is sufficient for this lab.
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Write C - code

5. Write a new source code file by clicking: File > New —> Source File. A new window will
open. Enter the file name “main.c”:

e New Source Fle x|
Create a new source file C
=
Source Folder: |Lab3 Browse... |
Source File: Imain.c
coes|

In the file “main.c” enter the following few lines:

1 mnEigned int k;
2 mneEigned int i:

wold main (vold)

{

o

while (1)
7 {

8 for (i=0; i<100; i++)
g {

10 k= i*i;

Save this file by clicking File = Save as and type in: Lab3.c

Build and Load

6. Click the “Rebuild Active Project” button or perform: Project = Rebuild Active Project and
watch the tools run in the build window. Debug as necessary. To open up more space, close
any open files or windows that you do not need at this time.

Create a Target Configuration

7. Before we can download the machine code into the F28335, we have to define the “target
configuration”.

=> Target = New Target Configuration
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& New Target Configuration
Target Configuration
Create a new Target Corfiguration file

File name: [F28335_xD5100v2]

[~ Use shared location

Location: [/Lab3/Debug Browss... |
Corce

Type a name for the target configuration file in box “File name”. You can use any name here
but it makes sense to indicate the JTAG-emulation interface, which we will use for the
download later. In case of the Peripheral Explorer Board we use the XDS100V2, so let us call
the file “F28335_XDS100V2. The suffix *“.ccxml” will be added automatically.

In the window that appears next, select the emulator “Texas Instruments XDS100v2 USB
the “Connection” pull-down list and select the “TMS320F28335” device

Emulator” via

checkbox.

Basic

General Setup

This section describes the general configuration about the target.

Connection

Board or Device

[Texas Instruments XD5100v2 USE Emulator

Jbvpe fiter text

[ TMS320F2803
[] TMS320F2810
] TMS320F2811
[] TMs320F2812
[] TMS320F28232
[] TMS320F28234
[] TMS320F28235
[] TMS320F28332
[] TMS320F28334
TMS320F28335
[]_TMS320R2810

Load Code into Target

8. Load the machine code into the device. Click:

=> Target = Debug Active Project

Or use the “Debug” icon:

A blue arrow should now point to the “for” — line in code file “main.c”. This is an indication
that the machine code has been downloaded properly into the F28335.

Test
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9. Reset the DSP by clicking on = Target =» Reset =» Reset CPU

== Disassembly {__etext + Bc3f633d) X
=
IErrterIc-cation here jl [ e | o 03 | 0
B 0x3FFSCE: 282000086 MOV [B5E, 40x0006 -
Ox3FFAD0: S81F SEIC OBJMODE
Ox3FFAD1: 5616 CLRC AMOLDE
Ox3FF9D2: ELa SEIC MOMIMAP
Ox3FF9D3: 2940 CLRC PAGEQD J
Ox3FF9D4: T61F0000 MOV DF, #0x0000
Ox3FF9D&: 2902 CLRC ovM
O0x3FF307: FF&9 SEM a -
_ i = - _>I_I

The blue arrow shows the current position of the Program Counter (PC), which is now loaded
with the hardware - reset address Ox3FF9CE in Boot-ROM.

10. Run the program until the first line of your C-code by clicking: Target =» Restart.

This command is often used directly after a RESET command. Its purpose is to bypass the
Boot — code and to load the Program Counter (PC) directly with the “entry point address” for
the code. This entry point address can be specified in the project options. For C-language
based projects the default address is the environment preparation function “_c_int00” (from
library rts2800_fpu.lib”

However, because we have enabled the auto run option to “main()”, the restart command will
run through “_c_int00” and stop at the beginning of “main()”. If this auto run option would
have been disabled, we could use = Target = “Go to Main” as a 3" command.

11. Open the Watch Window to watch your variables. Click: View - Watch. Add the two va-
riables ‘i’ and ‘k’ in the “name” column:

4 Watch (1) X o k| s & r Y
| Address | Type | Format

Ee0000C009&Data unsigned int Matural
0000C008=0ata unsigned int Matural

Code Step Comands

12. Perform a single-step through your program by clicking: Target - Step Into (or use function
Key F5). Repeat F5 and watch your variables.

13. Place a Breakpoint in the Lab3.c - window at line “k =i * i;”. Do this by placing the cursor
on this line, click right mouse and select: “Toggle Breakpoint”. The line is marked with a
blue dot to mark an active breakpoint. Perform a real- time run by Target = Run (or F8).
The program will stop execution when it reaches the active breakpoint. Remove the break-
point after this step (click right mouse and “Toggle Breakpoint™).
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Real Time Mode

14. Now we will exercise with the real-time debug mode. Make sure that all breakpoints have
been deleted or disabled.

Next, reset the device: =» Target = Reset = Reset CPU

This reset will set the device in its default state, including the watchdog unit, which is
enabled after reset. For this test we will have to disable the watchdog:

=> Scripts =»Watchdog =»Disable Watchdog
Now start the real-time debug:

=>» Scripts =» Real time Emulation Control = Run_Realtime_with_Restart

Now the code is running in real-time. The new feature is that we can interact with the device,
while the code is running. To practice using this:

=>» In the upper right-hand corner of the watch window, click on the white down-arrow
and select “Customize Continuous Refresh Interval”. Change the “Continuous Refresh
Interval” to 1 second instead of the default 5 seconds.

=>» In the upper right-hand corner of the watch window, click on the yellow arrows
rotating in a circle over a pause sign to enable continuous refresh mode for the watch
window.

£1%5 Debug G

TR R Gl a0

N

Ji

The contents of the Watch Window are updated frequently. The JTAG - controller uses
cycles, in which the core of the device does not access the variables to “steal” the information
needed to update the window. However, the USB-JTAG emulator is too slow to update the
watch window at the same frequency as our F2833x executes the for-loop. That is why we do
not see each increment of ‘i’ and ‘k’.

When you are done, stop the real - time mode by:
=>» Scripts =» Real time Emulation Control =» Full_Halt

Note: the test mode “Run_Realtime_with_Reset” will first perform a reset followed by a di-
rect start of the device from its reset address. The device will follow its hardware boot se-
guence (see Chapter 15) to begin the code execution. Since the Peripheral Explorer Board
sets the coding pins to “Branch to FLASH” by default, it would start code stored in FLASH.
The problem is, that so far we have not stored anything in FLASH (we will do this in Chapter
14). By using “Run_Realtime_with_Restart” we force CCS to place the program counter at

F2833x - Program Development Tools 3-43



Lab 3: beginner’s project

the start address of our project in RAM (a function called “c_int00”) and to start from this po-
sition.

15. Inspect the internal device registers:

= View =» Registers

Name | value | -
= &% Core Registers

bt ACC 0x000015F9
OXFFFFEFEF
0x00090000
0x00000000
Ox0000FFEFF
0x00000000
0x00000000
0x00000000
0x00000000
0x00000000
0x00008015
0x009085
0x0090&0
0x0080
0x0
0xl
0x0
0x0
0x0
0x0
0x0
0x0
0x0
0xCRO9

0x0300 L'J

When you expand the plus signs, for example for register STO, you can inspect details of the
particular register more in detail. At this early stage of the tutorial it is not important to
understand the meaning of all the bit fields and registers, shown in this window. But you
should get the feeling, that with the help of such windows, you can obtain control information
about all internal activities of the device.

There are two core registers, STO and ST1, which combine all core control switches and flags
of the CPU, such as carry, zero, negative, overflow, sign extension mode, interrupt enable
and so on. An inspection of these flags and bits allows you to immediately monitor the status
of the CPU in a certain spot of code.

The 32-bit registers ACC (“accumulator”), P (“Product”) and XT (“eXtended Temp”) are the
core math registers of the fixed - point arithmetic unit.

The 32-bit registers XARO to XAR7 are general-purpose registers, often used as pointer
registers or auxiliary registers for temporary results.

The register PC (“Program Counter”) points always the address of the next machine code
instruction in code memory. The register RPC (“return program counter”) stores the return
address of a function, which has called a sub-routine.

Watch Memory Contents
16. Let us open another control window, the “Memory Window”:
= View = Memory

Enter the address for variable k (“&k”) in the address box (top left corner box).
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This window allows us to inspect any physical memory location of the device, including
RAM, FLASH, OTP and Boot - ROM. Since the core of this device is a Digital Signal Pro-
cessor, we have always to remember that there are two memory spaces, code and data. To in-
spect variables, we have to select “data space”. For machine code instructions inspection we
have to look into “code space”. The selection is made in the top right corner box of this win-
dow.

=
[ ~EEa— ]|
LA e e

|Hex 16 Bt - C Style Hex 7|

s

0x0000C008

0x0000C00%9
0=x0000C00% oOx0190 Ox0000 Ox0000 J
0x0000C00C OxF658 O0x9183 OxD1F2
0x0000CO0F OxBAS4 0x0C00 0x0000
0=x0000C012 Ox0D003 Ox0000 Ox0000

-

The right center box allows us to specify the display mode of the 16-bit memory locations in
different form. Try using the different formats available: 16-bit hexadecimal, signed integer,
unsigned integer and binary.

Graphical Views

Time Domain Graph

17. A unique feature of Code Composer Studio (CCS) is the ability to display any region of
memory in graphical form. This is very helpful for inspection of data, such as sampled
analogue signals. We can display such memory values as raw data on a time - axis or even
better, we can display the samples a frequency axis. In the 2™ option CCS is performing a
FOURIER - transform, before it displays the data.

Let us inspect this graph feature:
=>» Tools = Graph =» Single Time

The BOOT-ROM contains a sine value lookup table of 512 samples for a unit circle of 360
degree. The data format is 32-bit signed integers in fractional 12Q30 - format. The start ad-
dress of this table is 0Ox3FEQQOQ. Enter the following parameters:
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Graph Properties (]

e

Acquistion Buffer Size 512

Dep Data Type 32 bit mgned integer
Index incremert 1
Q_Value k)
Sampling Rate HZ 1
Stan Address Ox He L0
=) Display Propertes
Aaia Disgdary ] true
Diata Flot Styin Line
Cisplay Daia Size 812
Gnd Style Major Gad
Magnitude Display Scale | Lineor
Time Display Ling sample
=1 Mac
Use Dc Value For Graph || alse

impot | Ewon | ok | cancel |

As a result, the graph window should display a single sinusoidal signal:

| 1]
[ sne Tme 1 |
HMES s-s o Rk-eeeigtlado”
4],9_
D.E-
1],1_
-D,B-
-D,?- /
11
[II‘IDDZDDEM 400 500
sample
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Frequency Domain Graph
Now open a second graph:
= Tools = Graph = FFT Magnitude

Enter the following properties:

[ vk

1
E!
1

13

37 b2 migromed irbegee

0

O 3FEODD

Frequency Chsplay Lng  Hz
Gind Shie Major Gnd
Magntude Display Scale  Linear

FFT Frame Size n
FFT Order []
FFT Window Function Hamming

[ TC R S =
1 . 1 . 1
.-'-'"-F'_’

—_

|

(=]
L

0 0.1 0.2

Sample

03

0.4

Close the graphical windows, when you are done.

F2833x - Program Development Tools



Lab 3: beginner’s project

Mixed Mode C and Assembly Language

18.

An important test method for inspecting both C and the resulting assembly code from the C -
compilation is called “Mixed Mode” - display. This option allows us not only to inspect and
verify the device steps both on C high-level language, but also on the device native
environment assembly language.

To visualize C and Assembler:

Right mouse click into the “Disassembly Window” and enable “Show Source”

assembly (main)

Erter location here

sHiesl=aE] s

8 for| (i=0; i<100; i++)
CSDWSLS main$2$B, CSL1, main:

»(0x00907A: TELFO300 MOVIW DB, #0x0300
0x00907C: 2B0E B8, #0
0x00907D: B
0x00907E: 5264 CMPB
0x00907F: &7FB 5B
10 k= i*i;

CSDWSLS main$3$B, CSL2, CSDWSLS main$23E:

0x0093080: 2008 MOV T, 8
N v
FlaeANN0T 100 M X e e A0
51 _>IJ

Optionally, use the green icon “Assembly Single Step” on the top window line.

r
(SN =T

1
¥
d

If you use “Assembly Single Step”, the code is executed machine code line by machine code
line. The dark blue arrow marks the next following assembly line. The light blue arrow
remains at the corresponding line of C code, as long as we deal with the assembly results of
that line.

When you have finished the mixed mode tests, please switch back to “Source Mode” (right
mouse click).

End of Exercise Lab3
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